
APA 
Formatting and Style Guide



What is APA?

American Psychological 

Association (APA)

is the most commonly 

used format for 

manuscripts in the Social 

Sciences.



What does APA regulate?

APA regulates:

Stylistics

In-text citations

References 

(a list of all sources

used in the paper)



Types of APA Papers

 The literature review: 

the summary of what the scientific literature says 

about the topic of your research–

includes title page, introduction, list of references

 The experimental report:

the description of your experimental research--

includes title page, abstract, introduction, method, 

results, discussion, references, appendices, tables 

& figures 



General Format

 be typed, double-spaced, with two spaces after punctuation

between sentences

 on standard-sized paper (8.5”x11”)

 with 1” margins on all sides

 in 12 point Times New Roman 

 include a page header (shortened title) in the upper left-hand of 

every page and a page number in the upper right-hand side of 

every page

Your essay should:



Title Page

The title should be centered in the upper half of the title page.

All words in a title except articles, conjunctions, and 

prepositions of less than four letters are capitalized.

Double-spaced and centered beneath the title is your name and 

two spaces below this is the full name of  your institution.

Running head – a shortened title, no more that 50 

characters in length, appears in the upper left corner of 

every page. 

The words “Running head” only appears on the title page.



Sample Title Page

Running head: EFFECTS OF STUDENT PERSEVERANCE   1

Effects of Student Perseverance:

Findings in a College Setting

John Doe

Kean University



Title Page

Page header:
(use Insert Page Header)

title flush left + page number 

flush right.

Title:

(in the upper half of the page, centered)

name (no title or degree) + 

affiliation (university, etc.)

(no date, no class name, no 

professor’s name)



Next Page

Will be numbered page 2

Does not have the words “Running head”



Page 2

EFFECTS OF STUDENT PERSEVERANCE                          2



Header: Different First Page

Go to the “View” menu.

Click on “Header and Footer."

Click on the icon that looks like an open book. (Page Setup)

Choose the “Layout” tab.

Check off “Different first page.”

Click “OK.”

Create the header you would like to have on the first page. This header will 

only appear on the first page. Click “Close” (6 icons to the right of page setup 

– the icon that looks like an open book).

Once you are on the second page, go to the “View” menu once again. Click 

on “Header and Footer.” Create the header you would like to have on the 

second page as well as each additional page thereafter. Click “Close” (6 icons 

to the right of page setup – the icon that looks like an open book). For each 

additional page, you will not need to create the header. The same header for 

the second page will automatically be the header for each additional page.



Level of Headings

APA Style uses a unique headings system to 

separate and classify paper sections. 

There are 5 heading levels in APA. 

Regardless of the number of levels, always use 

the headings in order, beginning with level 1. 



APA Headings

Level Format

1 Centered, Boldface, Uppercase and Lowercase Headings

2 Left-aligned, Boldface, Uppercase and Lowercase Heading

3
Indented, boldface, lowercase heading with a period. Begin body 

text after the period. 

4
Indented, boldface, italicized, lowercase heading with a period. Begin 

body text after the period. 

5
Indented, italicized, lowercase heading with a period. Begin body text 

after the period. 



Section headings receive level one format. Subsections receive 

level two format. Subsections of subsections receive level three 

format. For example:

Methods (Level 1)

Site of Study (Level 2)

Participant Population (Level 2)

Teachers. (Level 3)

Students. (Level 3)



Methods

Site of Study

This study was conducted in a classroom in a high school.

Participant Population

Eighty-three sophomores and their teachers participated in 

this study.

Teachers. Fifteen teachers responded to the survey.

Students. Students ranged in age from 15 to 17.



Results (Level 1)

Spatial Ability (Level 2)

Test one. (Level 3)

Teachers with experience. (Level 4)

Teachers in training. (Level 4)

Test two. (Level 3)

Kinesthetic Ability (Level 2)



In-text Citations

Whenever you take information from a source, 

provide in parenthesis;

- the author’s or authors’ names and the date of 

publication.

For example;

Smith (2010) found that X occurs often with Y.

or

X often occurs with Y (Smith, 2010).



In-text Citations: 

A work with two authors

• When citing a work with two authors, 

identify both authors whenever you cite the 

work.

• Example

Hernandez and Harris (2011) theorize 

that personality shows stability over time.



In-text Citations: 

A work with 3 to 5 authors

 When citing a work with three to five authors, 

the first time you cite the work, identify all 

authors in the signal phrase or in parenthesis:

(Harklau, Siegal, & Losey, 2009)

 In subsequent citations, only use the first

author's last name followed by "et al." in the

signal phrase or in parentheses:

(Harklau et al., 2009)



In-text Citation of a Website

If possible, cite an electronic document the same as 

any other document by using the author-date style.

• Example

Kenneth and Velez (2000) explained the cause as 

multifactorial.



In-text Citation of a Website

When citing an entire website, it is sufficient to give 

the address of the site in just the text.

• Example:

Kidspsych is a wonderful interactive website for 

children (http://www.kidspsych.org).

http://www.kidspsych.org/


In-text Citation of a Website

If there is no author, no year and no page numbers

your text citation would include the title (or short 

title) "n.d." for no date, and paragraph number.

Example (e.g., "Heuristic," n.d., para. 1). 



References

• The reference list at the end of your paper 

provides information necessary for the reader to 

identify and retrieve each source.



References Page

 Center the title–

References-- at the top

of the page

 Double-space

reference entries

 Flush left the first line

of the entry and indent

subsequent lines

 Order entries 

alphabetically by the

author’s surnames

Do NOT include 

“Running head:” 

in the header 

after the title 

page!



How to Reference a Website

Author, A. A., & Author, B. B. (Date of 

publication). Title of document. Retrieved from 

http://Web address

Example:

Angeli, E., Wagner, J., Lawrick, E., Moore, K., 

Anderson, M., Soderland, L., & Brizee, A. (2010, 

May 5). General format. Retrieved from 

http://owl.english.purdue.edu/owl/resource/560/01/



How to Reference a Website

When there is no author for a web page, the title 

moves to the first position of the reference entry:

• Example:

New child vaccine gets funding boost. (2001). 

Retrieved March 21, 2001, from 

http://news.ninemsn.com.au/health/story_13178.asp

For In-text citation

• Cite in text the first few words of the reference list 

entry (usually the title) and the year. Use double 

quotation marks around the title or abbreviated title.: 

("New Child Vaccine," 2001).

http://news.ninemsn.com.au/health/story_13178.asp


In-text Citations: Basics

 the author’s name and the date of publication

for quotations and close paraphrases, provide a

page number as well

Whenever you use a source, provide in parenthesis: 

In-text citations help readers locate the cited source 

in the References section of the paper. 



In-text Citations: 
Format for a quotation

 Caruth (1996) states that a traumatic response    
frequently entails a “delayed, uncontrolled repetitive
appearance of hallucinations and other intrusive   
phenomena” (p.11). 

 A traumatic response frequently entails a “delayed, 

uncontrolled repetitive appearance of hallucinations

and other intrusive phenomena” (Caruth, 1996, p.11).      

When quoting, introduce the quotation with a signal phrase. 

Make sure to include the author’s name, the year of publication, 

the page number, but keep the citation brief—do not repeat the 

information. 



In-text Citations: 
Format for a summary or paraphrase

 provide the author’s last name and the year of

publication in parenthesis after a summary or

a paraphrase:

Although feminist studies focus solely on women's

experiences, they err by collectively perpetuating the

masculine-centered impressions (Fussell, 1975).

There are several formats for a summary or paraphrase:



In-text Citations: 
Format for a summary or paraphrase

 include the author’s name in a signal phrase

followed by the year of publication in

parenthesis:

Recently, the history of warfare has been 

significantly revised by Higonnet et al. (1987), 

Marcus (1989), and Raitt and Tate (1997) to include

women’s personal and cultural responses to

battle and its resultant traumatic effects.

Formats for a summary or paraphrase (cont’d):



In-text Citations: 
Format for a summary or paraphrase

 when including the quotation in a 

summary/paraphrase, also provide a page

number in parenthesis after the quotation:

According to feminist researchers Raitt and Tate

(1997), “It is no longer true to claim that women's

responses to the war have been ignored” (p. 2).

Formats for a summary or paraphrase (cont’d):



In-text Citations: 
Two or more works 

 When the parenthetical citation includes two or

more works, order them in the same way they

appear in the reference list—the author’s name,   

the year of publication—separated by a 

semi-colon:

(Kachru, 2005; Smith, 2008)



In-text Citations: 
A work with two authors

 When citing a work with two authors, use “and”

in between authors’ name in the signal phrase

yet “&” between their names in parenthesis:

According to feminist researchers Raitt and Tate

(1997), “It is no longer true to claim that women's

responses to the war have been ignored” (p. 2).

Some feminists researchers question that “women's

responses to the war have been ignored” (Raitt &

Tate, 1997, p. 2).



In-text Citations: 
A work with 3 to 5 authors

 When citing a work with three to five authors, 

identify all authors in the signal phrase

or in parenthesis:

(Harklau, Siegal, & Losey, 1999)

 In subsequent citations, only use the first

author's last name followed by "et al." in the

signal phrase or in parentheses:

(Harklau et al., 1999)



In-text Citations: 
a work with 6 and more authors

 When citing a work with six and more authors, 

identify the first author’s name followed 

by “et al.” in the first and all subsequent citations of

the work;

Smith et al. (2006) maintained that….

(Smith et al., 2006) 



In-text Citations: 
A work of unknown author

 When citing a work of unknown author, use the 

the source’s full title in the signal phrase and 

cite the first word of the title followed by the

year of publication in parenthesis. Put titles of

articles and chapters in quotation marks; 

italicize titles of books and reports:

According to “Indiana Joins Federal

Accountability  System” (2008), …   

Or, 

(“Indiana,” 2008)



In-text Citations: 
Organization

 When citing an organization, mention the

organization the first time when you cite the 

source in the signal phrase or the parenthetical

citation:

The data collected by the Food and Drug

Administration (2008) confirmed that…

 If the organization has a well-known

abbreviation, include the abbreviation in

brackets the first time the source is cited and

then use only the abbreviation in

later citations:

Food and Drug Administration (FDA) 

confirmed … FDA’s experts tested…



In-text Citations: 
The same last name/the same author

 When citing authors with the same last names, 

use first initials with the last names:

(B. Kachru, 2005; Y. Kachru, 2008)

 When citing two or more works by the same

author published in the same year, use 

lower-case letters (a, b, c) with the year of

publication to order the references:

Smith’s (1998 a) study of adolescent immigrants…



If you need help with APA

There are several reference sources to get an 

answer to your specific question about APA:

OWL website: http://owl.english.purdue.edu

 Purdue Writing Lab @ HEAV 226

 composition textbooks

 Publication Manual of the American Psychological

Association, 6th ed.

 http://www.apastyle.org

http://owl.english.purdue.edu/
http://www.apastyle.org/


The End


